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WELCOME 

Thank you for purchasing Leonardo Design Studio. Please refer to this manual to install, 
setup, activate and to use the software. 

ABOUT LEONARDO  DESIGN STUDIO 

Leonardo Design Studio is standalone graphic design software that is for producing 
artwork to be sent to a Siser cutter.  
 

LEARNING RESOURCES 

Leonardo Design Studio has several resources for you to learn how to use the software.  

HOW TO USE THIS MANUAL 

The manual is accessed from the Leonardo Design Studio Help (menu) / Help Topics and 
opens with Acrobat Reader® which can be downloaded free from the Adobe website.  
 
HOW TO LOCATE/FIND TOPICS 
There are several ways to locate a help topic in the manual, as follows: 

1. Table of Contents: At the beginning of the manual click on the page number of 
the topic and you will be taken to that topic’s location in the manual.  

2. Navigation Pane: In Acrobat reader click the View (menu) / Show/Hide / 
Navigation Panes / Bookmarks and click the Bookmarks (see above) to be taken 
to the selected topic. 

3. Search: Click the Edit (menu) / Find and type in a keyword or phrase to find any 
topic that contains that word or phrase.  

4. Index: See the end of the manual for an index of important terms. 
 

FREQUENTLY ASKED QUESTIONS 
Many setup and how-to questions have already been answered online: 
https://www.Siserna.com/Leonardo-design-studio/  
 

VIDEO LESSONS AND TUTORIALS 
There are several videos online that will help you get started and then teach you how to 
use the software to its full capability. Please see the Tutorials Tab in the Software. 
 
 
 
 
 
 

https://fcl.software/legal/eula/
https://www.siserna.com/leonardo-design-studio/
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GETTING STARTED LESSONS 
If you have an Internet connection, click on each lesson below to bring it up to watch in 
your web browser.  
 

  
Unboxing and Quick Start Guide Exploring the Cutter User Interface 

  
Setup a Cutter Making Your First Cut 

  
Cutter Marker Adapter Print & Cut 

 
 
 
 
 

 

 

  

INSTALL AND ACTIVATE (UNLOCK) LEONARDO  DESIGN STUDIO  

OVERVIEW 

Leonardo Design Studio can be installed without being activated. However, to use the 
software without restriction it must be activated which is subject to the following 
conditions. 
 
Note: You must have purchased a valid subscription to unlock the Pro edition.  
 

SYSTEM REQUIREMENTS 

To operate Leonardo Design Studio the following computer configuration are below: 
 

Minimum Computer Configuration 

• 64-Bit Intel/AMD PC or 64-Bit Intel/M1 Mac 

• 100Gb of available hard disk drive space. 

• 8Gb of RAM. 

• SVGA color monitor set to a min 1024x768 pixels. 

• 512Mb SVGA video/graphics card. 

• 2 button Mouse. 
Microsoft Windows 8.1, or MacOS 10.15 (with properly configured antivirus). 
 

Ideal Computer Configuration 
• Intel i9, AMD Ryzen 9, or Apple M1 CPU  

• 100Gb+ of available hard disk drive space. 

• 32Gb+ of RAM. 

• Flat panel color monitor (1920 pixels). 

• 4Gb+ video/graphics card. 

• 2 button scrolling wheel Mouse. 

• Microsoft Windows 11 Pro, MacOS 13 (with properly configured antivirus). 
 

Note: Not having all the ideal computer configurations does not restrict you from using 
the software, as it can still function with minimum system requirements. 
 
 
 
 
 
 
 
 

https://www.youtube.com/watch?v=72iqWmMx1yQ
https://www.youtube.com/watch?v=7tKwvJAZ2Mw
https://www.youtube.com/watch?v=BINZa-oyW1c
https://www.youtube.com/watch?v=GKlH7PdtTFA
https://www.youtube.com/watch?v=AVd0VD7ecBM
https://www.youtube.com/watch?v=DMhgVJ51HUY
https://www.youtube.com/watch?v=72iqWmMx1yQ
https://www.youtube.com/watch?v=7tKwvJAZ2Mw
https://www.youtube.com/watch?v=BINZa-oyW1c
https://www.youtube.com/watch?v=GKlH7PdtTFA
https://www.youtube.com/watch?v=AVd0VD7ecBM
https://www.youtube.com/watch?v=DMhgVJ51HUY
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HOW TO INSTALL LEONARDO  DESIGN STUDIO 

Leonardo Design Studio is provided as a download. To install the software: 
 

1. The User account in Windows must have Administrator privileges (rights). 
2. The user must register using a valid email address and confirm their email 

address using a confirmation code sent via email.  
3. Use must agree to the software license agreement to install the software, see: 

https://fcl.software/legal/eula/ 
 
DOWNLOAD 
Click on, or type in the download link provided into an Internet browser and save the file 
to a known location. Note: The file may have to be set as safe with your antivirus software 
(search how to do this online) or it may have to be unblocked to run (right-click on the file 
and click Properties / Unblock). Once the file is downloaded open the file and follow the 
instructions for the software to install onto the computer. 
 

ANTIVIRUS SOFTWARE 

Your antivirus software must be configured to permit Leonardo Design Studio to operate 
without restriction. To do this, mark or set this folder and its subfolders and files as safe 
and/or quarantined from your antivirus software. 
 

ACTIVATE (UNLOCK) LEONARDO  DESIGN STUDIO 

To use Leonardo Design Studio without restriction the software must be activated 
(unlocked) via the Internet.  
 
HOW TO ACTIVATE  
The user must enter a valid email address and register their account to use the software. 
The user must validate their email address using a confirmation code sent via email. You 
may also have to provide your cutter’s Serial Number which is usually found on the back 
or underside of the cutter. 
 
Note: You must have purchased a valid subscription to unlock the Pro edition.  
 
If you have a Pro Trial edition, the program will include Trial in the Window Title, it will 
also include details on the expiry date of the trial, e.g., Trial – until XX/XX/XXXX).  
 

DOWNLOAD, INSTALLATION AND ACTIVATION PROBLEMS/ERRORS 

For Leonardo Design Studio to function correctly, Windows, all other programs and 
antivirus, drivers and networks must be properly configured and functioning without 
error.  

Windows/MacOS provides trouble shooting utilities and an online diagnostic (search 
online for: windows or MacOS fix it). There are answers to most setup and how to 
questions online:   
 
https://www.Siserna.com/Leonardo-design-studio/  
 
Please use these resources before contacting support which is only for Leonardo Design 
Studio faults and problems and is not for setup or training. If a problem persists, please 
visit: https://future.support   

https://fcl.software/legal/eula/
https://www.siserna.com/leonardo-design-studio/
https://future.support/


Leonardo Design Studio Manual - Page | 8 - Having problems? In Leonardo Design Studio click on Help / Support / Online Help 

 

LEONARDO  DESIGN STUDIO WORKSPACE 

Leonardo Design Studio uses menus, toolbars and tool panels as shown in this diagram:  
 

 
 
The flyout tools within the tool bar in the bottom left will automatically be able to be 
selected depending on what object or objects are selected in the designing area.  
 
From the Home Page or any of the tabs on the left menu you can select File menu to open 
recently saved files, a new page, go to page setup or open preferences etc.  
 
The My Pages menu on the left set of menus allows you to login/logout, edit account 
information and view recent files.  

HOME PAGE 

The Home Page tab features inspiration recommendations, quick access to useful videos 

and vinyl colors for you to access.  

TUTORIALS 

The Tutorials tab features a knowledge base of available tutorials. Click the Featured 

Tutorials drop down to expand available tutorial options including setting up the Siser 

cutter and vinyl basics. To the right you can locate the search function in which you can 

type in key words to navigate to a particular topic of concern.  

INSPIRATION  

The Inspiration tab highlights a variety of sample ideas and designs with instructions and 

required tools on how to complete the example projects. These are included at your 

disposal to assist with the design process and provide you with a foundation to enhance 

your creativity.  

DESIGN LIBRARY 

The design library tab is organized by category (click the drop down to select a category) 

and can be filtered and sorted by different specifications. You can also use the search 

function to discover potential designs for you to include in your projects. To use a sample 

design, click your selection and then press Open Design.   

 

You can use the arrows to scroll through the available options.  
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MATERIAL LIBRARY 

The material library tab is comprised with a drop-down list of available products that can 

be used for different purposes. Click on a product to expand information on the materials 

details, recommended uses and instructions for use.  

SISER  CUTTER 

The Siser Cutter tab allows you to register a machine and keep your software and 

firmware up to date, check on this page to ensure you never miss an update.  

MANAGE CUTTERS 

Click on File menu / Manage Cutters and the window to view Manage Cutters will open. 

 

From this window you can view your available cutters in list form.  

Add Cutter 

Add a new or remove an existing cutter.  

Edit/Rename 

Select the model type and add a name to your cutter, to easily identify the cutter. 

Connection 

Details such as the connection type (Wi-Fi or USB), the IP address and the port is 

available.  

You can also connect to a new and/or existing cutter via this setting. 

MY PAGE 

The My Page tab allows you to edit your account information and view your recent files.  

DESIGN 

The Design tab allows you to quickly navigate to the design space/Art Board/Cutting Mat 

and will keep your design saved if you navigate to a different menu. 

LEONARDO  DESIGN STUDIO TOOLS 

Each section (area) of Leonardo Design Studio tools are outlined, as follows. 
 

①  MENUS 
 
Leonardo Design Studio menus are commands grouped by the types of operations they 
perform and include most of the software’s tools and features. The menu’s functionality 
shown in the diagram below indicates: 

1. A submenu will reveal (display) when clicked. 
2. The command is not currently available. 
3. The currently selected command (click to perform). 
4. The keyboard shortcut for the command. 

 

  
②  COMMANDS 
 

 
 
A command is performed by clicking on its button.  
 
Note: Buttons may also be hidden in a dropdown or fly out as explained below.  
 



Leonardo Design Studio Manual - Page | 10 - Having problems? In Leonardo Design Studio click on Help / Support / Online Help 

 

DROPDOWN COMMANDS 

 

 
 
Click the dropdown boxes to reveal more buttons and settings.  

③ FLY OUT TOOLBARS 

 
 
Click and hover over the fly out buttons to reveal more buttons.  

④PAN/EDIT MODE & /ZOOM 

 
You can use panning mode either by holding down shift + the left mouse button and 
dragging, or by selecting the pan tool. To exit pan mode, click escape or select the pan 
button again to turn it off.  
 
Short Cut: Shift + Left Mouse Button (drag) 
 
You can zoom in by selecting the magnifying glass and clicking the page to zoom in. To 
reset the page, zoom back to 100%, select the 100% button. 
 

  
 
Short Cut: In zoom mode, Shift + click left mouse button to Zoom Out 
Short Cut: Zoom Mode: F2 
Short Cut: Zoom In: F3 

Short Cut: Zoom Out: F4 
Short Cut: Zoom to All: F5 

⑤  DESIGN CENTER 

 

The Design Center is a repository of Leonardo Design Studio’s major tools and features. 

The Design Center allows you to switch between Cutting Mat or Material Roll and includes 

the Properties relating to the objects on the page.   

Tip: Expand/hide the Properties settings by clicking the arrow in the top right.  
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PROPERTIES 

The properties section includes several features to manage and edit your objects/designs.   

①Color picker 
The color picker allows you to select the desired colors apply to objects, the outside ring 
allows you to select the color whilst the inside circle allows you to select the perfect 
shade.  

Applying HEX Values 

 

 
 
Note: Click the small circles and drag to change the applied color, the HEX value will 
change as you do this, indicating the current shade selected.  
 
By clicking on the color shade displayed a new window will open where you can adjust the 
HEX value by typing in the designated value and pressing ‘enter’/’return’ on your 
keyboard.  
 

  

Shown directly below is also a list of standard colors for your convenience. 
 

 

Fixed Color 

Selecting the Fixed Color button allows you to snap between a reduced range of colors for 
an easy selection. 
 

 

Fill Color 

Selecting FILL will fill the color of the objects within the enclosed boundary.  

Stroke Color 

Selecting STROKE will set the color of the outline of an object. 

Copying a Color 

 

To copy a color, use the cog next to the color wheel. Click the drop-down with an object 

selected to ‘Copy Color’, then select the new object, click the same drop-down and 

instead choose to ‘Apply Color’.  

Note: To select all items of the same color, click ‘Select Same Color’ from the dropdown 

(does not work when objects are grouped). From here, you can change all those shapes to 

a different color (simultaneously).  
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Colors in Use 

To apply a color that is already in use, click the color picker and on the left column a list of 

the colors in use is displayed and can be used to quickly apply colors already used in the 

workspace. 

Eye Dropper 

When selected, this tool will change selected colors to the color you click on.  

Short Cut: ‘Shift’ will select all shapes of the color you click on.  

Select by Color 

To select all shapes of the same color, click on the icon shown below. 

  

A window will appear allowing you to choose which color you want to filter the shapes 

being selected by. 

 

Click Accept to perform the action and Cancel to exit.  

② Size specifications  

Alter the width and height of an object by typing in your desired measurements. By 

default, the selected object will resize proportionally, to disable this setting and edit each 

the width and height individually, deselect the lock icon so that the lock is open.  

 

Measuring Units 

Alter your Measuring Unit Preferences by clicking File menu / Preferences / Measuring 

Units / Select your desired option from the available list.  

 

DOCUMENTS & PAGES  

Leonardo Design Studio works with multiple-page documents and each page can be the 
same or a different size.  

DOCUMENTS 

TO OPEN A DOCUMENT 

Click on the File menu / Open and the select file to open window will open. Next, 

navigate to where the File you wish to open is located, select the file and click 

open. 

TO OPEN A RECENT DOCUMENT 

Click on open recent or click on the File menu / Open Recent and the option to view 

recent files as thumbnails will open. 
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TO SAVE A DOCUMENT 

With a document open, click on Save or on the File menu / Save and the save 

window will open. Navigate to where you wish to save the file on your computer 

and enter a name for the file under file name and click Save. 

TO SAVE AS 

With a document open, click on Save As or on the File menu / Save As and the 

save as window will open. Navigate to where you wish to save the file on your 

computer and enter a name for the file under file name and click Save. 

FILE FORMATS AND EXTENSIONS 

Leonardo Design Studio opens and saves in the following native file formats: 

.LDS 

 

Leonardo Design Studio Document 

Includes all the elements of a document (objects, text, images, curves, symbols, 

pages etc.). 

   

JOB NOTES/STATISTICS 

*Only available in Leonardo Design Studio PRO. 

Job Notes 

Click on File menu / Jobs Notes/Statistics and the option to view the Job Notes and 

Statistics will open. 

 

Job notes allow users to document and store essential information related to a specific 

job or task, serving as a convenient reference or reminder system to track important 

details, progress, and instructions throughout the work process.  

To add a job note, just begin typing in the text area. 

 



Leonardo Design Studio Manual - Page | 14 - Having problems? In Leonardo Design Studio click on Help / Support / Online Help 

 

Note: Make sure to select Update once complete. Your job notes can be seen to the left 

of the toolbar. Hover over it to see a quick overview of the job note. 

Job Statistics  

Job statistics provide an overview of the statistics relating to all the objects within a 

document. It includes a section dedicated to the statistics on any selected objects. The 

types of statistics provided include the size, shapes, square coverage, total cutting length, 

total perimeter, etc. 

  

Note: This is useful when charging customers for jobs as the user can easily identify the 

total materials used.  

 

 

Cut History 

Once you have cut a job, you can review the cut history within Job Notes and Statistics to 

identify the previous times the job has been cut, the settings applied and in what color 

etc., as shown below. 

 

Note: This helps to identify whether you have cut out a particular piece of a job if you are 

unable to recall.  
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PREFERENCES AND SETTINGS 

Click on File menu / Preferences and the option to view preferences will appear. 

Tip: You can quickly edit the Measuring Unit and Language preferences from within the 

Menu, as shown below: 

 

Click on File menu / Preferences / All Preferences and the option to view Preferences & 

Settings will open. 

You will see two available windows, General Options and Editor Options. 

Once your chosen settings have been selected, click Accept to save the changes.  

 

General Options: General Preferences 

Language 

Set the language that you would like to view the program in. 

Measuring Units 

Set the unit of measurement, i.e., inches, millimeters, centimeters.  

Keyboard Nudge 

The amount/distance an object will move when using the arrow keys on the keyboard. 

General Options: Default Page Settings 

Small Page Margins 

Allows the user to print very close to the edge.  

Note: This should be done at your own risk. 



Leonardo Design Studio Manual - Page | 16 - Having problems? In Leonardo Design Studio click on Help / Support / Online Help 

 

Use Mat 

Select whether to create new jobs using a mat and set the default mat size.  

Dimensions 

Set the default page width and height to be used when creating new jobs. 

Editor Options: Mouse Editing 

Select tools that you want to perform only once when used, i.e., once the action is 

performed, the tool mode is exited and reverted to the Select tool.  

Editor Options: Dash Lines 

Select the custom dash size to be used in fold/die cutting jobs. 

PAGE SETUP 

Leonardo Design Studio comes with a selection of page sizes including all the most 
popular standard sizes. 

ART BOARD | CUTTING MAT  

Tip: Expand/hide the settings for the Art Board or Cutting Mat by clicking the arrow in the 

top right.  

To open Page Setup 
With nothing selected in the document, click the File menu / Page Setup. 

Page Size 

  

Leonardo Design Studio allows you to design either Cutting Mat mode or Material Roll 

mode.  

The Art Board/Cutting Mat dimensions can be set to the standard Siser cutting mat 

options.  

The Material Roll allows editing of the height/width however, this cannot be set to larger 

than the cutter to ensure accuracy when cutting.  

The Print Size can be selected using the Paper Size drop down. However, the option you 

want may be unavailable. As such, the dimensions can also be set using Paper Size which 

can be retrieved from the current printer in use by pressing the Printer button: 

 

Once clicked, it will expand the options for the paper sizes dependent on the currently 

connected printer, to change the paper size to that of another printer, select the desired 

printer from the drop-down box.  
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MEASURMENT & LAYOUT 

Leonardo Design Studio provides you with measurement and layout tools to assist you in 
drawing, aligning, and positioning objects, curves and text in the Drawing area. 

WORKING WITH A GRID 

The Grid is a series of intersecting lines that are set equidistant apart that you can use to 

precisely create, align, and position objects, text, or curves to in the Drawing area using 

the Snap to feature.  

WORKING WITH RULERS/WIREFRAME 

The Rulers are provided to accurately draw out, size, and align objects. The Rulers are 

intuitive as they automatically rescale as you zoom in and out and update with the 

current measurement units. 

 

Using Rulers 

Display or Hide the Rulers 

 

You can Display or Hide Rulers from the View menu / Show Rulers. 

Using Wireframe 

Display or Hide Wireframe 

 

You can Display or Hide Wireframe from the View menu / Show Wireframe. 

Short Cut: ‘W’ 

WORKING WITH LAYERS 

Layers are different levels on which you can place objects like vector lines, shapes, and 

other elements. They are used to separate parts of an image or drawing, allowing you to 

edit and manipulate individual elements of your artwork separately. 
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Using Layer Panels 

Add or Delete a Layer 

Use the plus and minus button on the bottom left side of the panel to remove or add a 

layer.  

Rename a Layer 

To rename a layer, double click on the text and a text box will be displayed, allowing you 

to edit the name for the layer. 

Note: This also works for the names of shapes/objects within in a layer.  

Lock a Layer 

To lock an entire layer, click the lock icon next to the Layer you wish to lock.  

Note: This also works for individual shapes/objects within a layer.  

Tip: Locking a layer is useful to prevent accidentally moving or clicking on a layer that you 

do not want to edit at a specific point in time.  

Tip: When using layers, turn on Page Marks and lock them to prevent accidentally moving 

the Page Marks when working on a job.  

Hide a Layer 

To hide an entire layer, click the eye icon next to the Layer you wish to lock.  

Note: This also works for individual shapes/objects within a layer.  

Tip: Hiding a layer is useful when you only want to send one of the layers to cut. i.e., if you 

are working with layers to be sent to cut in separate batches, hiding a layer ensures that 

when you select to send the design/send to cut, that the hidden layer will not be included.  

Arranging Layers 

Clicking a layer name and moving it above or below another layer has the same 

functionality as send to front/back. 

Tip: Rearrange the order of layers by clicking and dragging above or below. 

Note: This also works for shapes/objects within a layer.  

To move one object from one layer to another, expand both layers, click on the object in 

the layer panel and drag it into the layer you wish to include it in.  

Short Cut: ‘Control’/’Command’ + Left Mouse Button to select objects within a layer, or to 

select multiple layers.  

Short Cut: Shift + Left Mouse Button to capture all objects or layers includes within the 

area from the first selected object or layer.  

Selecting Layers 

Click on More on the layers panel to expand a list of options that are useful to choose 

from when working with layers, as shown below.  
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Print, Cut & Fold 

Inside the layers panel, when clicking on a specific object within a layer, the options for 

print and cut will become available, as shown below. 

  

The default option is to print. 

To change the option, click on the button and a drop-down box will appear with the 

options. Select the appropriate option for each object within your job.  

Print & Cut 

 

Tip: You may wish to import an image in which you wish to cut only a portion of that 

image in a particular shape.  

To do this, import an image as a background image (Import > Import File > Background 

Image) and click on the image within the layer. 

Next, select the image as Print and then place the shape over the top of the image, and 

select Cut Tool. By doing this, the section of the image within the shape over the top of 

the image will be cut.  

Note: These tools are also available from the Color Picker Properties menu (when an 

object is selected).  

Fold Lines 

You may wish to create a fold line using a different force of the same blade within a print 

and cut job. 

To do so, draw a line/curve (which can be identified in the layers) and position it in the 

location you wish to create a fold line.  
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Next, click Default (Print) to expand the drop-down and change the line to a Fold/Score – 

this will adjust the force of the line and prevent it from cutting through the media.  

 

Tip: Select whether you wish to use a solid line or a dashed line.  

Note: You can manually edit the force settings by Tool type, i.e., Cutting, Fold/Crease. 

Click Send Design and uncheck ‘Use Cutter’s Settings’ and you can manually adjust the 

force and speed for each tool.  

 

 

 

 

 

 

IMPORTING  

Leonardo Design Studio comes with Importing modules, which are used to insert into 

(open) 3rd party files directly into the current document.  

IMPORTING FILES 

Import any File Format 

To import a file, click File menu / Import and the Import window will open (as shown 

above). 

Next, navigate to where the file is located and click on the required File to highlight it, 

then click on the Import button. The Import Window will then disappear, and your import 

will complete. 

Short Cut: ‘Control’/’Command’ + I 

Drag & Drop 

You can also drag an Image file from a Windows Explorer or Mac Finder window directly 

into Leonardo Design Studio.   

INSERT IMAGE (BITMAP) 

Drag & Drop 

You can also drag an Image (.SVG) file from a Windows Explorer/Mac Finder window 

directly into Leonardo Design Studio.   

Note: When importing an image, by default, it will create a print and cut job 

automatically.  

IMPORTING IMAGES – IMPORT OPTIONS 

When importing an image, depending on the file type you will be given various options.  
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Importing images with file extension .PNG, .TIF, .JPG will take you straight to the Contour 

Cutting module. 

Editable Artwork 

 

Importing images with the file extension .SVG will allow you to choose between Print and 

Cut, Cut only or import the image as Editable Artwork. This is because SVG means scalable 

vector graphic, meaning the image is made up of geometric shapes that can be recognized 

in the software.  

If an image is imported as editable artwork, hovering over the image with the select tool 

will highlight each shape (as the mouse moves over it) that is contained within the group 

of shapes forming the image as shown below. 

 

Import a Background Image 

To import an image as a background image, select File > Import File and select 

‘Background Image’ as shown below. 
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Tip: This automatically sets the job as a Print & Cut job.  

SUPPORTED FILES  

Import 

The following is a list of the file formats Leonardo Design Studio imports: 

*.PNG *.TIF *.JPG *.SVG  

 

EXPORTING 

*Only available in Leonardo Design Studio PRO. 

Leonardo Design Studio comes with an Exporting module, which can be used to export 

artwork, meaning to download and save a file into an alternate format for use in a different 

program. 

EXPORTING FILES 

*Only available in Leonardo Design Studio PRO. 

Export Artwork Options 

To export a file, click File menu / Export Artwork and the Export window will open. 

 

When selecting to export artwork, a range of options will be available. 

You can choose whether to export all the artwork, or only the selected artwork if you 

have selected objects.  

Click Save and the program will prompt you to select a file location.  

Note: You can select to use the Current Page size, otherwise the export will be at the size 

of the current objects.  

Tip: If you have contour cut lines, you can select whether you would like to include them.  

Output Options 

You can select the DPI that the export renders an image to.  

Note: This may be used when a distortion has been applied.  
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Tip: Add padding to create a border around an image.  

SUPPORTED FILES  

Export 

The following is a list of the file formats Leonardo Design Studio exports: 

*.PNG *.TIF *.JPG *.SVG *.PDF 

 

Tip: .PNG and .TIF have transparent backgrounds whereas .JPG has an opaque or white 

background.  

WORKING WITH OBJECTS  

*Some tools only available in Leonardo Design Studio PRO. 

Begin designing in Leonardo Design Studio using the toolbar at the bottom left of the 

screen.  

 

SELECT TOOL 

 

This tool is used to select objects on your cutting mat/art board. 

The select tool by default is touch select and is shown as the left option in the fly-out 

menu. This means that if you hold down the left mouse button and touch any object, it 

will select the object.  

However, the second option in the fly-out menu is the select tool with the bound select 

mode applied. This means that if you hold down the left mouse button and select an 

option, the object will become selected only once inside the boundary marks drawn using 

the select tool. This is useful for when you only want to select certain things.  

Create a Copy 

Once an object is selected, you can create a copy by pressing ‘Alt’/’Option’ on your 

keyboard whilst holding down the left mouse and dragging the duplicated object to 

anywhere on your artboard or cutting mat.  

Note: Let go of the left mouse button whilst still holding ‘Alt’/’Option’ to ensure a 

successful duplication of the object.  

Delete an Object 

An object can be deleted by clicking Edit menu / Delete. 

RESIZE, MEASURE & ROTATE  

 

Resize 

When an object is selected, the outline will show circles around the perimeter of the 

object.  

Use the corner circles by clicking the left mouse button over the circle to resize in the 

direction of the relevant corner, proportionally, meaning the object will maintain its 

shape when resized.  
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Short Cut: If you hold down ‘Alt’/’Option’ when resizing from a corner circle (holding 

down the left mouse button), it will allow you to resize non-proportionally in any direction 

you move your mouse. 

Use the center circles on either the x or y axes by clicking the left mouse button over the 

circle to resize the object in the direction of the selected circle, non-proportionally, 

meaning the object will not maintain its shape and it will stretch in the direction that you 

drag the mouse.  

Short Cut: If you hold down ‘Shift’ when resizing, the object will resize from the center.  

Short Cut: If you hold down ‘Control’/’Command’ when resizing, the object will snap to an 

even multiple of the size (you can continue to drag to create a larger multiple).  

Short Cut: If you hold down ‘Control’/’Command’ + ‘Shift’ when resizing, you can 

simultaneously mirror the image.  

Note: Mirroring an image is useful for creating iron on t-shirt piece that needs to 

be pressed on backwards to show properly.  

Measure 

Whenever you select an object, the measurements along its ‘x’ and ‘y’ axes will appear, 

showing you the dimensions of the object that you are working with. As you resize the 

object, the measurements will change, if the measurement changing becomes blue, then 

you are resizing the object non-proportionally, meaning you are altering only the width or 

the height.  

Rotate 

The green circle adjacent to the object is used for rotating, as you rotate an object you 

will see the degrees in which it has been rotated.  

To rotate an object, click the left mouse button and drag the mouse in the direction you 

wish to rotate the object.  

Note: If you rotate near the center of the object, the rotation will snap to 15 degrees, if 

you rotate from further outside the center of the object, you can smoothly rotate to any 

angle.  

Short Cut: ‘Command’/ ‘Control’ + R 

NODE EDIT TOOL 

 

By selecting the node edit tool, the software will highlight all the nodes on the selected 

object as shown below.  

  

Round Corner  

Right click on a corner to bring up the option to round a corner of a node, you can drag it 

out at the same time to edit it.  

Add/Delete a Node 

Double click on a node to delete it and double click on an area without a node to insert 

one. 

KNIFE TOOL 

*Only available in Leonardo Design Studio PRO. 

The knife tool enables precise and controlled cutting or splitting of digital objects or 

shapes, simulating the action of a physical knife for efficient editing and manipulation in 

design or modeling workflows. 

Note: The knife tool is in the eraser pop up. 
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To use the knife tool, select the knife tool and then click and drag in the direction you 

want to split the object, release to complete the process.  

 

Note: If one object is selected, the knife will only cut through the selected object. If 

nothing is selected, the knife will cut through all objects included in the area that the tool 

is used across.  

Note: If a layer is locked, it cannot be cut/sliced using the knife tool.  

Short Cut: ‘Shift’ to disable snapping. 

Short Cut: ‘Escape’ to cancel. 

ERASER BRUSH TOOL 

*Only available in Leonardo Design Studio PRO. 

The eraser brush tool allows users to selectively remove or erase specific portions of 

digital content, mimicking the functionality of a physical eraser, for precise editing and 

refining of digital images or artwork. 

To use the eraser brush, select the eraser and click the left mouse button, dragging across 

the area you would like erased.   

 

Note: If one object is selected, the eraser brush will only function on the selected object. 

If nothing is selected, the eraser brush will function on all objects included in the area that 

the tool is used across.  

When the eraser brush is selected, a pop up will appear above the design area allowing 

you to select the shape and thickness of the eraser.  

Note: Selecting the line option will convert the eraser to erase as a line (snapping 

horizontally or vertically). 

 

Short Cut: ‘Shift’ held down allows you to resize the eraser brush.  

Note: The eraser tool is especially useful for stenciling to quickly erase out areas in text to 

avoid holes from falling out during the cutting process.  
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Hole Eraser 

Especially common in contour cutting, you might want to remove a hole, or part of a hole.  

 

Note: Instead of removing parts of shapes, this tool will only remove/erase the insides of 

holes. 

Slice Brush 

 

The slice brush creates a copy from where you have applied the slice brush tool.  

When using the Slice Brush, try working in Wireframe. 

Short Cut: ‘W’ 

 

In the above example, a line has been drawn across the word books, using the slice brush, 

its effect is visible in wireframe.  

PEN TOOL 

 

The pen tool is the first option of the 2 of the drawing tools.   

The pen tool can be used to draw lines.  

Lines 

To produce straight lines, click the left muse button and then move the mouse towards 

the desired length/direction and then click again to create a new node.  

Note: If you are working with curves, you can right click on a node to change it ‘To Line’. 

Curves 

To produce curves, click the left mouse button and then move the mouse towards the 

desired length/direction and then instead of simply clicking again to create a new node, 

hold down the left mouse button and drag the mouse in any direction/angle and the pen 

tool will create a curve at the relevant node.  

Note: Whilst creating the curve/line, you can click onto each node to edit it. Once you 

have clicked a node, arrows pointing in opposite directions will allow you to change the 

direction/angle of the node by clicking the arrow and dragging in the desired direction.   

By right clicking on the selected node, you can select the type of curve type to be used, 

changing the curves will affect the lengths and angles of the curve.  

i.e., A smooth curve means each side of the arrows that appear when editing the node are 

the same angle, but they can be different lengths, whereas a symmetrical curve means 

that the arrows are the same length, but you lose control over the angle.  

 

Working with Nodes 

There are a few things to note when working with lines/curves and producing nodes. 
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If you want to delete a node, you can double click it.  

If you want to finish a line/curve, right click on the node and it will give you the option 

‘Done’ which will produce the shape as a final object, or ‘Closed’ which will join the final 

node to the original node.  

Note: If you are drawing lines/curves and come close to/overlap the start/end point, the 

software will prompt you to close and finish, or continue editing. 

  

Once you finish a shape, you can select whether to leave the object as a stroke, or to fill 

the object (if enclosed). 

  

Vector Brush 

*Only available in Leonardo Design Studio PRO. 

 

The vector brush draws a vector path. To use the vector brush, select the vector brush 

tool and click the left mouse button, dragging to draw the vector path.  

 

When the vector brush is selected, a pop up will appear above the design area allowing 

you to select the shape and thickness of the vector path.  

Note: Selecting the line option will convert the vector brush to draw as a line (snapping 

horizontally or vertically). 

SHAPE TOOL 

 

Select the shapes flyout and click on a shape to select that option.  

To draw the shape, click anywhere in the drawing area, hold down the mouse button and 

drag out the shape, when satisfied with the shape let go of the mouse button.  

Note: Once you have made your shape, the software automatically stores the shape/size 

and allows you to create duplicates simply by clicking the left mouse button anywhere in 

the drawing area to produce your shape in that position.  
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This is an efficient way to produce multiple copies! 

Copy/Delete an Object 

To add a copy, select Edit menu / Add a Copy 

To delete a shape, select Edit menu / Delete 

Short Cut: Hold down shift after drawing a shape to create a proportional version of 

recently created object. Click the left mouse button and release to position the new shape 

in the position of the cursor.  

Short Cut: Delete an object by pressing ‘Escape’. 

TEXT TOOL 

 

The text tool allows you to create and edit text as shown below.  

 

Type text simply by clicking in the text editing area. 

To change the font, scroll through the options on the left and select the desired font.  

Note: Quickly change through fonts by highlighting the selected font and using the 

up/down arrow keys on your keyboard to change fonts whilst applying it to your written 

text.  

 

Tip: You can filter by fonts that are available in your chosen language (the language you 

have installed the program in).  

The text can also be made Bold or Italicized using these buttons: 
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Short Cut: Select Text + ‘Control’/’Command’ + B to Bold a font. 

Short Cut: Select Text + ‘Control’/’Command’ + I to italicize a font. 

 

To change the text’s justification, select using the drop-down box.  

 

The text’s size can be edited using the arrows, or by typing in the size into the box.  

 

The text tool also includes the option to Auto Weld Text so that text with overlaps 

removes the gaps which will allow the text to be sent to cut (objects with gaps cannot be 

sent to cut). 

  

The text tool also includes the option to Show Glyphs so that you can identify all the 

glyphs/characters available in the selected font.  

Note: To edit text that has been created, double click the text and the text editing window 

will appear, allowing you to revise the font, size, justification etc. 

Arc Text 

*Only available in Leonardo Design Studio PRO. 

Arc text allows users to create text that follows a curved or circular path, enabling the 

placement of text along arcs, circles, or other custom shapes, enhancing design flexibility, 

and enabling creative typography effects in various graphic design or layout applications. 

To add arc text, expand the text fly-out and select Arc Text.  

A window will appear that displays all the available arc text settings.  

Click in the text box to type text.  

 

Once the desired selections have been made, select Apply to update the changes.  
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Background 

Select whether to display the background. 

Font Size 

Edit the size of the text. 

Font Style 

Select the desired font and whether to apply bold or italics settings.  

Radius 

Edit the size of the radius from where the arc text is positioned.  

Angle 

Adjust the angle on the arc from where the arc text is positioned. 

Baseline Position 

Adjust the distance from the baseline of the arc from where the arc text is positioned.  

Justification 

Select whether to center the arc text on the arc.  

For multiline text, select whether to display the text above, below, or above and below 

the arc. 

Bottom Adjustment 

Controls the vertical positioning of the text along the arc. 

Line Space 

For multiline text, adjust the spacing between lines. 

Text on Path 

*Only available in Leonardo Design Studio PRO. 

To add text on path, first create a path using the vector brush.  

Next, expand the text fly-out and select Text on Path.  

Click in the text box to type text.  

 

Path Offset 

Adjust the offset from the path from which the text is positioned on.   

Start Position 

Adjust the starting position along the path that the text begins. 

Baseline Position 

Adjust the distance from the baseline of the path from where the text on path is 

positioned.  

Flip Text 

Select whether to mirror the text.  
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CONTOUR CUTTING TOOL 

 
Leonardo Design Studio comes with a dedicated Cut-Contour module which automatically 
outlines selected Objects using a system color. 
 
To use the contour cutting tool, select an object and click the Cut-Contour module button, 
or import an image to open the contour cutting module.  

WHAT IS CONTOUR CUTTING 

  
A Contour Cutting Line or Outline is a special purpose curve that can be identified by a 
printer/cutter to print then cut out your artwork from a single file.  
 

 
 

What is Contour Cutting? 

A Contour Cutting Line or Outline is a special purpose curve that can be identified by a 

printer/cutter to print then cut out your artwork from a single file.  

Note: ARMS (Automatic Registration Mark Sensing) is a generic term used for vinyl cutters 

that use an automated system to identify the location of printed marks for great contour 

cutting accuracy. Some manufacturers use different terms for this system which can be 

used interchangeable with the term: ARMS. 

 

Contour Cutting involves placing an outline around an Object or Objects in Leonardo 

Design Studio. The Object(s) but not the Outline are printed onto media such as white 

vinyl, later the Outline is cut out using special Registration Marks (ARMS) or a Laser 

Pointer and a Vinyl Cutter, which then creates a decal or sticker. The Outline can be set at 

any distance from the edge of the Object or Objects and cut out from a separate vinyl 

cutter or on a Printer-Cutter. An example of Contour Cutting is shown above. 

Print, Laminate & Cut 

Another application of Contour Cutting is to create a Cutline around an artwork's 

perimeter. The artwork (not the Cutline) is then printed and later laminated, and the 

Cutline then cut out to create the finished artwork.  

THE MASK EDITOR 

The Mask Editor is a specialist utility used to remove the background from images 

(transparent) and/or to create special effects by using transparencies within the image. 
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Masks are introduced as an Alpha Channel with an imported Image (bitmap). 

Vectorizing, otherwise known as Tracing takes an Image (Bitmap) and traces around its 

pixels to create an editable and perfectly rescale able curve (path) that can either cut out 

using a plotter (vinyl cutter), printed and/or exported.  

A mask can be understood as an area over an image that makes it transparent (see 

through).  

 

To trace an image and apply a mask, import an image, and set the following sections as 

required. 

Adjusting the Tracing Level/Remove Background 

The mask tolerance will adjust which colors show up when importing the image.  

You can switch off the grid by unchecking Show Grid to identify which colors are being 

imported in a different view as shown below (adjust preview opacity to further clarify 

which colors are included in the import).  

Use the sliding bar or the arrows to control the mask tolerance (amount/level of colors to 

be incorporated in the import).  

 

Advanced Masking Tools/Selecting the Trace Areas  

The Advanced Masking tools provide a more in-depth method to adding/removing colors 

that will be included for the final import. 

SELECT COLOR RANGE 

Check Select Color Range to remove/include specific colors selected using the color 

matching tool by hovering and clicking over the chosen color on the image.  

The preview of the color will show up next to the mouse button for your convenience 

when completing this step.  

 

DRAWING TOOLS 

There are a variety of drawing tools that can be used to remove elements in the image. 

Refer to the following steps to remove part of the image that is not to be included in the 

cut job (this is useful when elements of an image are too small/difficult to cut).  
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The image above shows a horse with a collar that creates an outline that may not be 

wanted in the final cut job. To remove it, select Drawing Tools under the Advanced 

Masking Tools and use whichever drawing tool is appropriate to remove the element.  

In this instance, the curve tool was used to draw over the unwanted area. 

 

Below is a side-by-side comparison of the area prior to and after removal. Once the area 

has been drawn over, click Enter on the keyboard to apply the changes.   

 

Below shows the contour line, depicting the removed element.  

 

Traced Contours  

Smoothing Level 
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The smoothing level can be edited as shown above to alter the accuracy to which the 

image is traced around, see below for a smoothing level of 0 compared to 100. 

 

CUTTING CONTOURS 

Contour Offset 

Apply the desired contour offset which is the space/border added around the image. 

From here, you can decide whether to include holes and to clip the artwork (hide 

background), adding transparent areas instead of keeping unnecessary backgrounds. 

 

Contour Bleed 

After you trace your image and it is ready to import, you can select whether to Include 

Contour Bleed, this will prevent alignment issues when cutting as the tool adds a slight 

border around the artwork.  

You can control the bleed color and the bleed offset (thickness of the bleed) – do so by 

using the arrows or by typing in the desired bleed level. 

 

To identify the bleed applied, try zooming in using the Zoom tools.  
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There is also an option to include a small inner bleed which can be applied if the artwork 

border is one color and is used to improve print quality.  

WORKING WITH CONTOUR CUT  

 
To build a contour cut, select the object, and click Edit menu / Build Cut Contour, or 
import an image and you will be prompted to complete the same steps. 
 

 
 
The following module will appear: 
 

 
 
By default, when importing an image, the Print and Cut option will be selected. 
 
Note: You can also access Build Contours from the Contour Cutting tool. 
 
You can select from 2 options: 
 

1) Print and Cut Logo 
2) Editable Contour (cut only) 

Offset Amount 

Adjusts the offset of the contour around the image. 

Tip: You can edit the offset after applying it simply by using the build contours tool and 

changing the amount.  

Note: To individually edit/remove a cut-contour, use ungroup paths to separate the image 

from its contour. 

Corner Style 

Determines whether a round or sharp corner style is applied to corners of the contour. 

Include Holes 
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Select whether to include or remove holes within the contour. 

Die Cut 

Select whether the contour is to be used for die cutting.  

Print & Cut Logo 

Print and cut logo will allow you to apply contours for cutting and work with the image to 

be printed.  

Editable Contour (Cut Only) 

Editable contours will allow you to apply contours for cutting.  

Note: Applying contours to an image/shape/object that was originally a print job, will 

convert it to a cut job as well.  

WELDING TOOL 

Welding is a method of joining and combining shapes, curves and text including any 

effects to each other to create new curve objects, that can also have effects applied to 

them and again be welded, as shown, and explained below: 

 

Welding is used because you cannot have overlapping spaces when sending an object to 

the cutter.  

 

When two or more objects are selected, welding and shaping tools will become available 

in the tool bar at the bottom left. 

Short Cut: ‘Control’/‘Command’ + ‘W’ 

Note: Weld operations also operate on stroke lines.  

Weld Selected    

 

To weld objects together, use the select tool (bound select) to select all the objects that 

will be welded together. Next, click on the welding tool flyout in the toolbar and click 

weld. All will be converted into a Single Object with the color based on the item most 

below in the Z-Order (as shown in the example directly above). 

When Welding Objects, try working in Wireframe. 

Short Cut: ‘W’ 

Note: Welding can be used on cursive texts that originally have overlap, to remove these 

overlaps to allow the text to be sent to cut, as shown below.  
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The text tool also does include the option to ‘auto weld text’, check the box as shown 

below when creating text.  

 

Weld Selected (keep overlaps) 

This tool is used to ensure that some shapes do maintain applied overlaps, for example in 

the section below (make compound), there will be projects in which shapes will require 

negative space such as holes.  

Weld selected whilst keeping overlaps ensures that these new shapes that have been 

created with negative space, will be maintained with negative space when welding to 

other objects.  

To weld selected (keep overlaps), select a shape with overlaps present as shown below. 

 

Then, expand the welding flyout and select ‘Weld (keeps overlaps)’.  

Make Compound 

The welding tool can be used to create negative spaces inside other objects, for example, 

if you want to create a hole inside of a circle, the ‘Make Compound’ tool can be utilized.  

First, create a circle and then create a smaller circle inside that circle (work in wireframe).  

Next, use the select tool to select both items as shown below.  
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Next, select the weld tool to expand the welding flyout, and select the Make Compound 

tool.  

Once you turn off wireframe, you will notice a hole inside the circle.  

 

Note: To maintain the circle with the hole inside it when welding to other objects, make 

sure to first weld (keep overlaps) this new shape after setting it to make compound.  

Short Cut: Right Click > Paths > Combine Paths. 

Release Compound 

To release the compound and allow the shapes to be edited individually separated, click 

‘Release Compound’. 

 

Short Cut: Right Click > Paths > Break Paths. 

Short Cut: Right Click > Paths > Ungroup Paths (keep holes inside shapes). 

Punch Out 

*Only available in Leonardo Design Studio PRO. 

 

 

To punch out from a group of objects, arrange the objects in the desired position.  

Next, ensure the objects you wish to shape are selected and then select Punch Out. 

Note: The object above will Punch Out (remove) from the selected objects below, as 

shown in the example above.  

Tip: Learn how to set Z Order (above and below). 

Note: If nothing is selected, everything will be punched out. If a group or a singular object 

is selected, only the singular or group of objects that are selected will be punched out.  

Stamp 

*Only available in Leonardo Design Studio PRO. 
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Stamp operates the same as Punch Out, but it also keeps the top layer/shape/object 

instead of completely removing it.  

To stamp (to punch out and keep the shape), arrange the objects in the desired position.  

Next, ensure the objects you wish to shape are selected and then select Stamp. 

Note: The object above will Stamp.  

Tip: Learn how to set Z Order (above and below). 

Note: If nothing is selected, everything will be stamped. If a group or a singular object is 

selected, only the singular or group of objects that are selected will be stamped.  

Intersect 

*Only available in Leonardo Design Studio PRO. 

 

 

Intersect keeps the part of the object intersected by the selected shapes.  

To intersect, arrange the objects in the desired position.  

Next, ensure the objects you wish to shape are selected and then select Intersect. 

Note: All the selected items are intersected with the top clipping shape (the punch out 

shape). 

Slice Intersect 

*Only available in Leonardo Design Studio PRO. 

 

 

Like the Slice Brush, when applying slice intersect, along the border that the shapes are 

intersected, the Slice Intersect tool will split the shape into two separate parts. 

To slice intersect, arrange the objects in the desired position.  

Next, ensure the objects you wish to shape are selected and then select Slice Intersect. 

Color Layer Weld 

 

Color layer weld splits objects so that there is no overlapping of the shapes.  

Note: This is useful when working with objects of the same color to avoid wastage during 

the cutting process (and you do not want overlap). 

To color layer weld, arrange the objects in the desired position.  

Next, ensure the objects you wish to shape are selected and then select Color Layer Weld.  
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The example above illustrates the product of color layer weld, where the objects of the 

same color are welded into one shape and any objects of a different color are split apart.  

Base Layer Weld 

*Only available in Leonardo Design Studio PRO. 

 

In some instances, you might want all the shapes on top of one background.  

To base layer weld, arrange the objects in the desired position.  

Next, ensure the objects you wish to shape are selected and then select Base Layer Weld.  

When working with base layer weld, you will be prompted to select the base layer color 

on a pop-up screen as shown below: 

 

Select your chosen color and the output should look as follows (every other shape is on 

top of the selected layer): 

 

Note: This significantly simplifies the process when assembling a job, such as sticker jobs. 
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SCALE TOOL  

 

The scale tool features 4 tools: rotate, mirror (horizontally), mirror (vertically) and 

duplicate.  

Note: The scale tools can also be used from Arrange menu.   

Rotate 

To rotate an object by 90 degrees in a clockwise direction, use the rotate tool which is the 

first option in the scale flyout menu.   

 

Short Cut: ‘Command’/‘Control’ + R 

Mirror 

The mirroring tool can be found in the scale flyout and can be selected either horizontally 

or vertically. Mirroring objects is especially useful for projects relating to iron on transfers, 

where the object must be mirrored in its application to a t shirt or similar.  

Horizontally 

Select an object using the select tool and then select the mirror horizontally tool from the 

scale flyout menu to mirror an object from its center along the x axes.  

Vertically 

Select an object using the select tool and then select the mirror horizontally tool from the 

scale flyout menu to mirror an object from its center along the y axes.  

Duplicate  

 

Select an object using the select tool and then select the duplicate tool to create quick 

copies of the object.  

Short Cut: ‘Control’/’Command’ + C to copy and then Control’/’Command’ + V to paste 

the duplicate.  

The shortcut for Duplicate is the Plus (+) from the keyboard. 

Note: The duplicate will need to be moved off the original by clicking the left mouse 

button and dragging to the desired location.  

How to Cut, Copy, Paste 

Tile Array 

*Only available in Leonardo Design Studio PRO. 
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Select an object using the select tool and then select the Tile Array tool to create quick 

copies of the object in the desired formation (horizontal and vertical quantities).  

Tip: Set the horizontal/vertical space to your desired gaps. To fit the page with as many 

quantities as possible in the cuttable area, select Auto Fit. 

 

Note: Grid lines are useful when weeding or die-cutting (making each object detach as 

separate squares).  

 

Rotated Array 

*Only available in Leonardo Design Studio PRO. 

 

 

Select an object using the select tool and then select the Rotated Array tool to create 

quick copies of the object around a circle. 

Tip: Set spacing to your desired gap. 

Note: Deselecting auto-calculate radius allows you to keep a set quantity of shapes and 

set the radius larger or smaller. 

CUT 

To remove a selected object from the document and place it on the Clipboard, select the 

object and click Cut. 

Cut is also available from the Edit and Right-click menu. 

Short Cut: ‘Control’/’Command’ + X 

COPY 

To copy a selected Object and place it on the Clipboard click on Copy.  

Copy is also available from the Edit and Right-click menu. 

 Short Cut: ‘Control’/’Command’ + C 

PASTE 

To insert an Object (in its original position) from the Clipboard and place it in the 

Document click on Paste or click the Dropdown to select an object from the previously 

copied objects. 

Paste is also available from the Edit and Right-click menu. 

Short Cut: ‘Control’/’Command’ + V  
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WARPING/DISTORTIONS TOOL 

*Only available in Leonardo Design Studio PRO. 

Warping refers to the manipulation of visual or audio content by applying various 

transformations that alter its shape, position, or characteristics, often used for creative or 

experimental purposes. 

 

Note: To edit a shape in distortion mode, you can also use the Edit Curves menu option to 

display the editable nodes. 

Note: Distortions can be compounded together, meaning you can fit a distortion around 

another distortion and so on.  

Short Cut: ‘Shift’ + Corners > Both control points will follow. 

Short Cut: Right Click > Returns to object mode.  

Mesh Warp 

*Only available in Leonardo Design Studio PRO. 

 

Mesh warp allows you to distort an object as if it were on a piece of rubber. 

 

Flag Warp 

*Only available in Leonardo Design Studio PRO. 

 

Flag warp allows you to distort an object as if it were on a flag. 

 

Globe Warp 

*Only available in Leonardo Design Studio PRO. 

 

Globe warp allows you to distort an object as if it were on a globe. 
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Note: To create a circle, resize the globe until it becomes circular. 

Tube Warp 

*Only available in Leonardo Design Studio PRO. 

 

Tube warp allows you to distort an object as if it were on a tube or cylinder. 

 

Note: Tube warp is often used when warping text, the top node is often moved to be flat 

in the horizontal direction, creating an effect as shown below. 

 

Arc Warp 

 

*Only available in Leonardo Design Studio PRO. 

Arc warp allows you to distort an object as if it were on a circle. 

 

Note: You have control over the center position, inner radius, outer radius, the spread of 

the object, and angle within the circle.  

Short Cut: Hold down ‘Shift’ to prevent from snapping to 90°. 

3D Warp 

*Only available in Leonardo Design Studio PRO. 

 

3D warp allows you to distort an object as if there were a perspective vanishing point. 
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Note: Use 3D warp on text to create a shadow that appears as though it is being cast, as 

shown below. 

 

Cone Warp 

*Only available in Leonardo Design Studio PRO. 

 

Cone warp allows you to distort an object as if it were on a cup. 

 

Tip: Set the Top Mark selection so that you can easily identify how far the design is from 

the top of the cup (represented by an indicator in the design page). 

Note: There are several settings allowing you full control over the size, shape, and 

position of the cup. 

ARRANGE TOOL 

Note: The arrange tools can also be used from Arrange menu   

 

When two or more Objects are grouped together, they are treated as a single Object but 

retain their individual attributes and remain individually editable. Grouping Objects lets 

you apply the same formatting, properties, and other changes to all the Objects within 

the group at the same time. You can also group a selection of existing groups (Nested 

Groups) to preserve the spatial relationships (relative positioning) between each set or 

unit of Objects, as shown in the examples below: 

Group Objects 

Grouping greatly assists in maintaining the relative positioning Objects and formatting 

large numbers of Objects. 

To group together different objects on your artboard/cutting mat, use the select tool to 

select all objects that are to be grouped.  

Next, expand the arrange fly-out and select Group.  

This will allow you to work with selected objects as one object, meaning it can be moved 

around as one object whilst maintaining the spatial relationship between the objects 

which allows you to do things such as resize the objects simultaneously.  



Leonardo Design Studio Manual - Page | 46 - Having problems? In Leonardo Design Studio click on Help / Support / Online Help 

 

Short Cut: ‘Control’/’Command’ + G 

Ungroup Objects 

To ungroup together different objects on your artboard/cutting mat, use the select tool to 

select all objects that are to be ungrouped. 

Next, expand the arrange fly-out and select Ungroup.  

Ungroup does not ungroup Nested Groups (Groups within Groups) i.e., it only Ungroups 

to the first level of Groups, see Ungroup All below.  

Short Cut: ‘Control’/’Command’ + U 

 

Ungroup Paths 

 

Ungrouping paths refers to the action of separating or breaking apart a grouped set of 

paths or objects into their individual components. 

Paths are used to define shapes, lines, and curves. Grouping paths allows you to treat 

multiple paths as a single unit, making it easier to manipulate and manage them 

collectively. However, there are times when you may want to edit or modify individual 

paths within a group, which is where the ungrouping paths feature becomes useful. 

By ungrouping paths, you can access and manipulate each path independently, enabling 

you to make specific adjustments or apply different styles, colors, or transformations to 

individual components. It allows for greater control and precision when working with 

complex illustrations, logos, or another vector-based artwork. 

To ungroup all objects, use the select tool to select all the grouped objects.  

Next, expand the arrange fly-out and select Ungroup Paths. 

Short Cut: ‘Shift’ + ’Control’ + U  

Now, all paths will be individually editable.  

 

In the example above, you will notice in the layers tab all the different components to the 

originally grouped shape. 
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Tip: Ungrouping paths is different to breaking paths such that in ungrouping paths the 

holes that might be required, i.e., in text, are kept. Ungroup paths allows you to keep the 

holes inside each shape, whilst still splitting up the actual curve.  

Note: This is useful when working with text/objects that are designed to have holes.  

Ungroup paths also allows you to import an image with multiple elements and it will 

automatically detect these, so that you can split them into their own shapes, as shown in 

the example below.  

 

The artwork is originally imported and identified as one layer. By ungrouping paths, each 

part becomes its own shape, as illustrated below. 

 

Ungrouping Cut Contours 

Ungrouping paths can be used when working with objects that that have had cut contours 

applied, e.g., a cut contour and a die cut contour in addition to the image itself.  

Ungrouping paths allows you to individually edit and work with each path.  

 

In the example above, a heart shape has had a cut contour and a die-cut contour applied. 

They have been moved side by side for demonstration purposes.  

Tip: To individually edit cut contours or the object itself on an object that has had these 

applied, simply ungroup paths and lock the layers that you do not want to edit.  

Tip: To delete and replace a cut-contour, ungroup the paths and simply delete it from the 

layers panel. You can then create a new cut-contour using the Contour Cutting tool.  
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Z-ORDER (ABOVE AND BELOW) 

Leonardo Design Studio provides Z-order tools for all objects including curves, images, 

shapes, and text plus all the effects which can be applied to these objects within a 

Document. The Z-order tools can be found in the scale fly-out, from the toolbar at the 

bottom left.  

 

Z-order relates to sending objects ‘to front’ or ‘to back’, i.e., sending one object in front 

of, or behind another object.  

Set Z Order (drop down) 

 

Select the Object that you wish to adjust and click on the scale fly-out and click on the 

required Z-order Position (send to front or send to back). 

The Z-order tools are also available from the Arrange and Right-click menus. 

Short Cut: Send to Front/Send to Back as below. 

Send to Front: ‘Control’/’Command’ + Page Up  

Send to Back: ‘Control’/’Command’ + Page Down 

SPACE TOOL (ALIGNMENT) 

 
Leonardo Design Studio comes with a large suite of Alignment, Distribute and Space Apart 
tools and features to assist you in laying out your work accurately and to save your time. 
Note: These tools and features are limited in Leonardo Design Studio Basic. 
 

Note: The space tools can also be used from Arrange menu. 

ALIGNMENT TOOLS 
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Leonardo Design Studio comes with a large suite of alignment tools to assist you in laying 

out your work accurately and to save your time. The alignment tools are designed to work 

on (a) the objects themselves, or (b) the page the objects are associated with, or (c) the 

active object which is simply the last selected object in the alignment group. This system 

provides for comprehensive alignment of all your objects when working with the 

program. 

Default Shortcuts 

The following are the default Align Keyboard Shortcuts when one or more objects are 

selected in Object-mode (unless changed by the user): 

 

Align Left L 

Align Right R 

Align Top T 

Align Bottom B 

Align Centers Horizontally E 

Align Centers Vertically C 

Open the Alignment Tools 

To align objects, click on Space Objects fly-out menu to expand the alignment tools.  

The Align tab provides you with several alignment combinations. 

Note: You can access the alignment options from Arrange menu / Align to Page which 

includes for the functions Align Objects and Align to Page.  

Align Objects to Each Other  

When multiple objects have been selected, then the alignment tools will apply the 

alignment to each other.  

Align Objects to Page Center 

When a singular object is selected, the alignment tools will automatically apply the 

alignment to page center. 

Align Object(s) as a Group to Page Center 

To align several objects as a group to page center, select all the objects and then click 

Arrange menu / Align to Page and the select which page alignment the objects should be 

sent to.  

Space Apart Tools  

 

The final option in the Space Objects flyout is Space Objects Apart. This tool can be used 

to evenly distribute the objects on the design area apart from each other.  
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PRINT & CUT 

WORKING WITH PRINTING & CUTTING 

Once you are satisfied with the image import including applied mask, contour offset and 

contour bleed, you can proceed with the print and cut job.  

Ensure you are working in Art Board/Cutting Mat mode (not designing mode), as shown 

below.  

  

In your Art Board/Cutting Mat settings, check Print and Cut Job to send items to print and 

items to cut.  

 

Note: If you only want to cut an object/artwork, uncheck Print and Cut Job and the 

artwork will only be treated as a Cut Job, and as such will be converted to a flat color, as 

shown below.  

 

Mark Spacing 

When working with a Print and Cut job, you can adjust the Mark Spacing, which are the 

marks at each corner surrounding the shape of the object/artwork. To adjust the mark 

spacing, make sure to check ‘Print and Cut Job’, and the tools will become available.  

 

You can set to use Page Marks which will set the marks at the boarder of the selected 

page size, indicating the space that your object occupies within the page.  

Or you can set the Mark Spacing to a custom amount by changing it in the typing space. 

 

Note: If your marks highlight red, this is because they are set too far at the boundary of 

the selected page size. If you position your objects too far apart and the mark space is set 

too high, the marks will show up red to indicate that there is not enough space to work 
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with. To rectify, you can use the Page Marks button to adjust the Park Marks to anywhere 

within the ‘safe’ area on the page, around the edge.  

This is designed to make sure the cutter can scan the marks and the printer does not 

compromise the marks when printing.  

See below the marks in which the design for the job will be included within. This is where 

you can see a final preview of your artwork. 

 

Switch back to the Design tab by clicking Back to Design to make any further changes. 

 

When the design is ready for output, click Send Design 

 

Shown below depicts the printable artwork and cuttable artwork, and as such the image 

to be sent to the printer, as well as potential cutting contours which is simply an outline 

surrounding the image that can be used to be cut out by a cutter. 

 

The Machine’s Properties will appear on the top right of your document.  
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There are a variety of Cutter and Printer properties that can be applied/edited to ensure 

the artwork is produced to the highest quality and that the process is easy for the user, 

these will be discussed in the relevant section below.  

Tip: You can manually edit the force settings by Tool type, i.e., Cutting, Fold/Crease. 

 

PRINTING 

Leonardo Design Studio simplifies the cutting process by allowing the user control over 

the cutting settings and ensuring the options they need are at their disposal.  

MACHINE 

Once you have selected to send a design to print, the user will be shown which machine is 

connected along with the properties to print.  

 

Connecting to a Machine 

Select a printer from the drop-down box (the software will recognize the printers that 

have been saved to or used by the computer being used).  

 

PRINTING PROPERTIES  

Page Setup  

To bring up printer properties, click Set Page Printing Size 
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This will bring up a setup menu with the following options shown below. 

 

Format For 

Select the printer from the drop-down box. 

Paper Size 

Select a standard paper size or set custom dimensions.  

Orientation 

Select from Portrait (vertical) or Landscape (horizontal). 

Scale 

Set the print scale. Reduce or enlarge the printout by entering a percentage. 

If you’re printing a document to a paper size that’s different from the size the document 

was formatted for, select the “Scale to fit paper size” option in the Print dialogue. 

Print Size 

If the print size appears red, as shown below, this indicates that it is too large for the 

current print job, Set Print Size using the button to match the print size to the job size.  

 

The Print Size can be selected using the Paper Size drop down. However, the option you 

want may be unavailable. As such, the dimensions can also be set using Paper Size which 

can be retrieved from the current printer in use by pressing the Printer button: 

 

Once clicked, it will expand the options for the paper sizes dependent on the currently 

connected printer, to change the paper size to that of another printer, select the desired 

printer from the drop-down box.  

Recenter 

The recenter button simply allows you to recenter the artwork if you have moved it too 

far in one direction and cannot locate the best position to place the artwork.  

CUTTING 

Leonardo Design Studio simplifies the cutting process by allowing the user control over 

the cutting settings and ensuring the options they need are at their disposal.  

Layer Marks  

 

A useful tool that supports the cutting process is the Layer Marks option.  

This tool, when applied, ensures that all elements (within one design/artwork), are sent to 

a position relative to each other on the cutting mat/material roll that is displayed when 

sent to cutter.  

For example, each element that is sent to cut when Layer Marks is not selected, will be set 

to cut from the Cut Origin (bottom left of the media). However, for elements that need to 

be cut on the same media, in their relative position, require the application of the tool 

Layer Marks.  
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The left picture above shows Layer Marks selected; the right picture above shows when 

Layer Marks are not selected. You can see the difference in cutting origins for each 

element of the cut job.  

Note: The Arrange menu / Move to Cut Origin allows you to reset the position of the 

object/artwork to be cut, to the Cut Origin.  

Note: Make sure Print & Cut job is turned off to allow the Layer Marks tool to be used.  

Print, Cut & Fold 

When an object has been selected, the default option for print and cut will become 

available inside the layers panel and the color picker, as shown below. 

         

The default option will depend on the type of object selected. 

To change the option, click on the button and a drop-down box will appear with the 

options. Select the appropriate option for each object within your job.  

Print & Cut 
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Fold Lines 

You may wish to create a fold line using a different force of the same blade within a print 

and cut job. 

To do so, draw a line/curve (which can be identified in the layers) and position it in the 

location you wish to create a fold line.  

 

Next, click Default (Print) to expand the drop-down and change the line to a Fold/Score – 

this will adjust the force of the line and prevent it from cutting through the media.  

 

Tip: Select whether you wish to use a solid line or a dashed line.  

Note: You can manually edit the force settings by Tool type, i.e., Cutting, Fold/Crease. 

Click Send Design and uncheck ‘Use Cutter’s Settings’ and you can manually adjust the 

force and speed for each tool.  

 

Note: The software will automatically complete the fold lines first, and then proceed to 

the cut lines when sending a job to the cutter. 

Perforation Cut  

A perforation cut, or full cut, is used for jobs such as stickers.   
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To perform a perforation cut, select your shape, and then select the Build Contours from 

the Menu. Select Editable Contour and add an offset to the current shape, this will create 

a new shape which can then be set to perforation cut (choose between the desired line 

type), as shown below.  

 

Tip: Set the force of the perforation cut to higher than that of the regular cut – allowing 

the cut tool to cut through the material of the sticker itself, and the perforation cut to cut 

through the backing for the sticker.  

Note: The software will automatically complete the fold lines first, and then proceed to 

the cut lines when sending a job to the cutter (using the applied settings for each type of 

cut, respectively).  

CUTTING MACHINE 

Once you have selected to send a design to cut, the user will be shown which machine is 

connected.  

Connecting to a Machine 

To connect to a device, click Cutting menu / Set Device Connection, or by clicking the 

settings (cogs) symbol on the bottom right of the Machine Properties. From this step the 

user will be prompted to connect to a device either using USB connection, or WIFI 

connection as shown below.  

 

Select the applicable option and follow through the onscreen instructions to connect to 

your cutter. 

Note: Leonardo Design Studio is only compatible with Siser cutters.  

Once the cutter connection has been established, the user can proceed to setup cutting 

properties.  

Switching Devices/Managing Cutters 

To bring up the window outlining the details on the connected cutter and to switch 

between cutters, click on the cutter name. 

 

Note: You can also access this window from Cutting menu / Select Cutter. 

Tip: If you have multiple cutters and have named them in the Manage Cutters menu, try 

hovering over the selected cutter from the cut page to quickly identify you have the 

correct cutter selected. 
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CUTTING PROPERTIES  

Cutting Mat vs Material Roll  

The cutting mat size can be selected from the available drop-down box and allows the 

user to accurately visualize the amount of space the design/artwork will take up on an 

actual cutting mat.  

 

The material roll alters the size of the area where the design is located, applying the 

dimensions of the media to be used, so that the user can accurately visualize the amount 

of space the artwork will take up on the vinyl itself. 

The media dimensions can be edited as shown below.  

  

Note: This is only available in Cut only mode, not Print and Cut (uncheck Print and Cut 

Job). 

Below depicts the artwork within custom media dimensions.  

 

If the artwork is too close to the edge, the edges will appear red, indicating that the 

designs position needs to be changed to ensure no elements will be compromised which 

would waste media and likely frustrate the user.  

 

Note: To navigate out of this page and continue editing your design, click Back to Design. 
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Cutting Presets 

Blade Tool 

The user can select from a drop down to apply the standard blade which will mean they 

do not need to edit the settings, apply a pen tool which is used for drawing, or apply 

custom settings, allowing the user to edit the Blade Offset and Calibrate the cutter.  

Speed/Force 

The user can select to Use Cutter’s Settings by checking the box as shown below. 

 

Unchecking this box will allow the user to edit the speed and force of the cutter by typing 

in the level of speed/force in the applicable box. The bar in the center depicts the 

percentage in which the speed/force applied is, relative to the cutters highest level of 

speed/force.  

 

Mirror 

The mirror option can be checked for projects such as heat transfers, where adhesive side 

of the material is facing the blade and the artwork must be cut mirrored. 

 

Auto Weed box 

The auto weed box can be checked to apply a Weed-Box (a cutline around the perimeter 

of the artwork) to each object. 

  

Save to PLT File 

The PLT file format is a vector-based plotter file. Plotting details require accuracy and 

precision in production, and usage of PLT file guarantee this as all images are printed 

using lines instead of dots. You can save to PLT File from Cutting menu / Transmit PLT File.  

Saving as a PLT file means the artwork can be opened again whilst maintaining all the 

vector information, so it would be ready to cut at a later time.   

 

Area Test 

The user can send a test cut to the cutter to ensure it is working as expected. You can also 

access Area Test from Cutting menu / Area Test 

 

Area test sends the blade to each of the 4 corners in the cutting area to ensure that it will 

cut successfully.  

SEND TO CUTTER 

Shown below depicts the cuttable artwork and as such the cutting contours (outline) to be 

sent to cut. 

To bring up the window outlining the details on the connected cutter and to switch 

between cutters, click on the cutter name. 

 

Note: You can also access this window from Cutting menu / Select Cutter. 

Tip: If you have multiple cutters and have named them in the Manage Cutters menu, try 

hovering over the selected cutter from the cut page to quickly identify you have the 

correct cutter selected. 
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Once the settings have been selected and the artwork is ready to cut, select the 

objects/artwork you want to send to cut, and then click Send to Cutter and follow the 

onscreen instructions.  

 

Note: Send to cut will only send what has been selected. If nothing is selected, all of the 

objects get sent to cut (grouped by color).  

Tip: Arrange your objects in the send to cut section closely together to save media!  

Note: To navigate out of this page and continue editing your design, click Back to Design. 

 

Separate by Color 

 

By default, the artwork will be separated by color so that you can load your vinyl by each 

color and proceed to cut.  

Tip: If for some reason you do not need to separate the artwork by color, after pressing 

Send to Cutter/Send Design, check ‘Don’t separate by color’ to see the cut job inclusive of 

All Colors (treating all colors as the same cutting path), as shown below.  
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CUTTING 

Once you have clicked Send to Cutter, you will be prompted to confirm the applied 

settings.  

Click Yes to proceed or click No to change the settings.  

Note: Check that you haven’t sent the force too high.  

Cutting in Process  

Once you have sent something to cut, the object outline will convert to green to indicate 

that is being processed, as shown below.  

 

Wireframe Mode for Objects to Cut 

If you switch back to the design center and turn on wireframe mode, you can detect what 

is being sent to cut as the outline will be converted to blue, as shown below.  
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SHORTCUTS 

Add a copy after drawing a shape: Shift + Click and Release Left Mouse Button 

Add Copy: + 

Bold Font: Select Text + ‘Control’/’Command’ + B to Bold a font. 

Bring to Front: Page Up↑ 

Copy: ‘Command’/ ‘Control’ + C 

Cut: ‘Command’/ ‘Control’ + X 

Delete: DEL 

Delete: Escape 

Group: ‘Command’/ ‘Control’ + G 

Import: ‘Command’/ ‘Control’ + I 

Italicize Font: Select Text + ‘Control’/’Command’ + I to italicize a font. 

Mirror whilst resizing: ‘Control’/’Command + Shift + Left Mouse button when resizing 

New Page: ‘Command’/ ‘Control’ + N 

Open Page: ‘Command’/ ‘Control’ + O 

Pan Mode: Shift + Left Mouse Button  

Paste: ‘Command’/ ‘Control’ + V 

Redo: Page Up ‘Command’/ ‘Control’ + Z  

Resize from center: Shift + Left Mouse Button when resizing 

Resize in even multiples: ‘Control’/’Command’ + Left Mouse button when resizing 

Resize non-proportionally: Alt/Option + Left Mouse Button when resizing 

Rotate: ‘Command’/ ‘Control’ + R 

Save: ‘Command’/ ‘Control’ + S 

Select All: ‘Command’/ ‘Control’ + A 

Send to Back: Page Down↓ 

Show Rulers: R 

Show Wireframe: W 

Undo: ‘Command’/ ‘Control’ + Z 

Ungroup: ‘Command’/ ‘Control’ + U  

Weld: ‘Command’/ ‘Control’ + W 

Zoom In: F3 

Zoom Mode: F2 

Zoom Out: F4 

Zoom to All: F5. 
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REFERENCE 

TERMINOLOGY LINKS 

Before you get started with Leonardo Design Studio, you should become familiar with our 

terms which you will find throughout this manual, as follows: 

GLOSSARY 

A - B - C - D - E - F - G - H - I - J - K - L - M - N - O - P - Q - R - S - T - U - V - W - X - Y - Z 

A 

Accent: A modifying mark on a character. For example, the accent marks in Latin script 

(acute, tilde, and ogonek) and the tone marks in Thai. Synonymous with diacritic.  

Agent: Interactive assistants which form part of the Super Tutor training program. 

Aliasing: A technique usually used for displaying bitmap files. 

Alpha-blending: A convex combination of two colors allowing for transparency effects. 

The value of alpha in the color code ranges from 0.0 to 1.0, where 0.0 represents a fully 

transparent color, and 1.0 represents a fully opaque color. 

Alpha Channel: A portion of each pixel's data that is reserved for transparency 

information. The alpha channel is an 8-bit channel, which means it has 256 levels of gray 

from 0 (black) to 255 (white). White acts as the visible area; black acts as the transparent 

area. 

Animated GIF: Animation saved as a graphic interchange format file i.e. a graphic image 

that moves. 

Animation: Movement created by combining images. 

Anti-alias: The blending of pixel colors on the perimeter of hard-edged shapes, like text, to 

smooth undesirable edges 

Antivirus software: A computer program that attempts to identify, neutralize or eliminate 

a wide range of threats to a computer or device, including but not limited to (i) malware, 

(ii) worms, (iii) phishing attacks, (iv) rootkits, and (v) Trojan horses or any other type of 

similar, related or malicious software. 

Apple computer: A computer or device manufactured, supplied and/or sold by Apple 

Computer Inc. or its Authorized or Licensed Dealers. 

Arabic numerals: The characters 1, 2, 3, 4, 5, 6, 7, 8, 9, and 0. Contrast with Chinese 

numerals, Hindi numerals, and Roman numerals.  

Arabic script: A cursive script used in Arabic countries. Other writing systems such as Latin 

and Japanese also have a cursive handwritten form, but usually are typeset or printed in 

discrete letter form. Arabic script has only the cursive form, and is also used for Urdu, 

(which is spoken in Pakistan, Bangladesh, and India), Farsi or Persian (which is spoken in 

Iran, Iraq, and Afghanistan).  

ARMS (Automatic Registration Mark Sensing) is a generic term used for vinyl cutters that 

use an automated system to identify the location of printed marks for great contour 

cutting accuracy. Some manufacturers use different terms for this system which can be 

used interchangeable with the term: ARMS. 

ASCII: "American Standard Code for Information Interchange." A standard 7-bit character 

set used for information interchange. ASCII encodes the basic Latin alphabet and 

punctuation used in American English but does not encode the accented characters used 

in many European languages.  

Ascende: Any part of a lower-case character which extends above the X-height. 

ASP: Active Server Pages (ASP). Tool or computer application that is used to create 

dynamic and interactive web pages. 
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Banner: (1) Header or title of magazine or periodical publication and a Web page. 

Graphical advertisements are placed in banners on web sites, or (2) A flexible substrate 

(e.g., canvas) used to make a sign usually on a temporary basis. 

Baseline: A conceptual line with respect to which successive characters are aligned. 
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Bevel: (1) A process of giving a raised appearance by using highlighting colors and 

shadows, or (2) A mathematical process of outlining and mitering a vector object to give a 

raised appearance. 

Beta software/version: A version of Software that is in its final development and/or 

testing stage that may contain bugs, errors and other glitches or problems. 

Bidirectional (1): A communication standard between a computer and a device to send 

and receive packets of data.  

Bidirectional (2): Languages such as Arabic, Hebrew, and Yiddish whose general flow of 

text proceeds horizontally from right to left, but numbers, English, and other left-to-right 

language text are written from left to right.  

Bitmap image or graphic: A graphic image stored as specific pattern of dots to form a 

picture when viewed from a distance. 

Bit-mapped (mode): The Paint graphics mode describes an image made of pixels where 

the pixel is either on (black) or off (white). 

Bleed: Extending the colors, background, or objects outside (beyond) the defined page 

border or graphic by a set distance which is printed (usually on over-sized media/paper). 

The additional area that has been printed is then trimmed to the original or final page 

size. 

Browser: Software for accessing, viewing and managing web pages e.g., Explorer, Mozilla, 

Firefox.  

Black (font): A font that has more weight than the bold version of a typeface. 

Blackletter (font): A Gothic (middle-ages) font style. 

Block quote: A long quotation - four or more lines - within body text, that is set apart to 

clearly distinguish the author's words from the words that the author is quoting.  

Block shadow: A mathematical process of giving an extruded appearance in 3D to a vector 

object. 

Body type: Roman - normal, plain, or book - type used for long passages of text, such a 

story in a newsletter, magazine, or chapters in a book. Generally sized from 9 point to 14 

point. 

Byline: In newsletter/magazine layout, a credit line for the author of an article. 
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Cap height: In typography, the distance from the baseline to the top of the capital letters. 

Caption: An identification (title) for an illustration, usually a brief phrase. The caption 

should also support other content.  

Cast Shadow: A mathematical process of giving the appearance of a naturally cast shadow 

in 3D from a single light source (usually the Sun) to a vector object. 

Character: Any letter, figure, punctuation, symbol, or space (whether visible or not). 

Character set: A collection of characters in which a numeric code is assigned to each 

character so that it can be represented on a computer. 

Chinese numerals: Chinese characters that represent numbers. For example, the Chinese 

characters for 1, 2, and 3 are written with one, two, and three horizontal brush strokes, 

respectively. 

Code page: A synonym for character set.  

Collation: Text comparison using language-sensitive rules as opposed to bitwise 

comparison of numeric character codes. 

Cursive script: A script whose adjacent characters touch or are connected to each other. 

For example, Arabic script is cursive.  

Clipart: Raster or Vector based objects that form graphic art. 

Color spacing: Achieving a pleasing appearance after the line has been set normally. 

Component: A separate and identifiable part of our Software that may be obtained 

separately for a fee or at no charge as described in the Software’s documentation that 
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seamlessly integrates with the Software and is typically referred to as a plug-in, snap-in or 

module. 

Computer Related typeface: A structured typeface that does meet standard typography 

conventions such as serif or sans serif which has a computer-based aspect. 

Cookie: Cookies are the form of temporary files stored on the user’s computer. They 

identify web site users/visitors. 

Crop marks: On a mechanical, horizontal, and vertical lines that indicate the edge of the 

printed piece. 

Cropping: For artwork, cutting out the extraneous parts of an image, usually a 

photograph. 
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Decorative typeface: A structured typeface that does meet standard typography 

conventions such as serif or sans serif. 

Descender: In typography, the part of the letterform that dips below the baseline; usually 

refers to lowercase letters and some punctuation, but some typefaces have uppercase 

letters with descenders. 

Diacritic: A modifying mark on a character. For example, the accent marks in Latin script 

(acute, tilde, and ogonek) and the tone marks in Thai. Synonymous with accent.  

Dingbat typeface: A typeface made up of non-alphabetic marker characters, such as 

arrows, asterisks, encircled numbers.  

Discretionary hyphen: a hyphen that will occur only if the word appears at the end of a 

line, not if the word appears in the middle of a line.  

Display type: Large and/or decorative type used for headlines and as graphic elements in 

display pieces. Common sizes are 14, 18, 24, 30, 36, 48, 60, and 72 point. 

Dither: For digital halftones, the creation of a flat bitmap by simply running dots on or off. 

All dots are the same size there are simply more of them in dark areas and fewer of them 

in light areas - as opposed to deep bitmaps used in gray-scale images.  

Dongle: A piece of hardware that physically attaches to a computer or Device (typically 

through its Parallel, Serial or USB communications port) that is interrogated by the 

Software to determine its authenticity and a user's right to fully access the Software. 

Double-byte Character Set (DBCS): A set of characters in which each character is 

represented by 2 bytes. Scripts such as Japanese, Chinese, and Korean contain more 

characters than can be represented by 256 code points, thus requiring two bytes to 

uniquely represent each character. The term DBCS is often used to mean MBCS (multibyte 

character set). 

DPI (dots per inch): The unit of measurement used to describe the resolution of printed 

output. The most common desktop laser printers’ output at 300 dpi. Medium-resolution 

printers’ output at 600 dpi and up to 1200 dpi. Large Format Printers typically output at 

50-2880 dpi and Image setters’ output at 1270-2540 dpi. 

Drop shadow: Drop shadows are those shadows dropping below text or images which 

gives the illusion of shadows from lighting and gives a 3D effect to the object.  

Duotone: A halftone image printed with two colors, one dark and the other light. The 

same photograph is half-toned twice, using the same screen at two different angles; 

combining the two improves the detail and contrast.  
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Egyptian type: Originally, from 1815 on, bold face with heavy slabs or square serifs. 

Em space: A space as wide as the point size of the types. This measurement is relative; in 

12-point type an em space is 12 points wide, but in 24-point type an em space is 24 points 

wide. 

Emboss: Embossing a graphic image adds dimension to it by making the image appear as 

if it were carved as a projection from a flat background.  

Encoding Scheme: A set of specific definitions that describe the philosophy used to 

represent character data. Examples of specifications in such a definition are the number 

of bits, the number of bytes, the allowable ranges of bytes, maximum number of 

characters, and meanings assigned to some generic and specific bit patterns.  
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En space: A space half as wide as the type is high (half an em space) 

Export: Exporting allows the user to save the file in another format to be opened in other 

programs.  

Expanded (font): A font in which the set widths of the characters are wider than in the 

standard typeface. (Note: not the inter character space - that is accomplished through 

letter spacing - but the characters themselves). 

Extended type: Typefaces that are abnormally wide horizontally. 
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Feather: A process of applying a blur to an image. This process gradually dissolves the 

area of the image on which the feather is applied.  

Flash: Vector graphic animation software developed by Adobe (formerly) Macromedia 

that creates browser-independent graphics (graphics that look the same across all 

browsers). An advantage of Flash animation is that the download time is relatively fast. 

Flight/Pre-Check: Program used to identify missing fonts, embedded graphics, bad traps, 

and many other possible problems. 

Folio: A page number, often set with running headers or footers. 

Font: A set of graphic characters that have a characteristic design, or a font designer's 

concept of how the graphic characters should appear. The characteristic design specifies 

the characteristics of its graphic characters. Examples of characteristics are shape, graphic 

pattern, style, size, weight, and increment.  

Four-color process: The printing process that reproduces colors by combining, cyan, 

magenta, yellow and black (CMYK). Six color is usually the addition of light cyan and 

magenta to improve color tones and enhance definition. 

Forms: Source of collecting information from the viewer or user. 
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Galleys: In traditional publishing, the type set in long columns, not laid out on a page. In 

desktop publishing, galleys can be printed out using a page-assembly program, for 

proofreading and copy fitting purposes. 

GIF: (Graphic Interchange format) GIF images display up to 256 colors. GIF images 

generally have very small file sizes and are the most widely used graphic format on the 

web. The low quality resulting from compression makes them unsuitable for professional 

printing or vectorizing (tracing).  

Glyph: The actual shape (bit pattern, outline) of a character image. For example, an italic 

"A" and a roman "A" are two different glyphs representing the same underlying character. 

Strictly speaking, any two images that differ in shape constitute different glyphs. In this 

usage, glyph is a synonym for character image, or simply image.  

GMT: Greenwich mean time. In the 1840s the standard time kept by the Royal Greenwich 

Observatory located at Greenwich, England was established for all of England, Scotland, 

and Wales, replacing many local times in use in those days. Subsequently GMT became 

the official time reference for the world until 1972 when it was subsumed by the atomic 

clock-based coordinated universal time (UTC). GMT is also known as universal time.  

Gradient: A function in our graphic software that allows the user to fill an object/image 

with a smooth transition of colors, for example a dark blue, gradually becoming lighter or 

green, gradually becoming red, then orange. 

Greeked text: In page-assembly programs, text that appears as gray bars approximating 

the lines of type rather than actual characters. These speeds up the amount of time it 

takes to draw images on the screen (rarely used anymore due to the advent of faster 

computers). 

Graphic design: Visual representation of an idea or concept. The term is used as a 

collective name for all activities relating to visual design, including web design, logo design 

etc. 

Greyscale: A color mode in which Black and White colors and in combination. 

Gutter: In double-sided documents, the combination of the inside margins of facing 

pages; the gutter should be wide enough to accommodate binding.  
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GUI: Graphic User Interface allows user to use graphics, picture, and icons instead of text. 

Leonardo Design Studio uses an advanced GUI interface. 
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Halftone: A tone that is halfway between highlight and dark shadow. The tones are 

broken up by fine screen into different sizes of dots. 

Handwritten typeface: A typeface that does meet standard typography conventions such 

as serif or sans serif. 

Hangul: The Korean alphabet that consists of fourteen consonants and ten vowels. Hangul 

was created by a team of scholars in the 15th century at the behest of King Sejong. 

Head: Line on the top of the body of content which is in big and bold fonts. 

Hexadecimal: A number system used for web colors. The first six numbers used in these 

16 based numbering systems are 0-9 and the next 5 are A-F. 

Hiragana: A Japanese phonetic syllabary. The symbols are cursive or curvilinear in style. 

Hue: the actual color of an object. Hue is measured as a location on a color wheel, 

expressed in degrees. Hue is also understood as the names of specific colors, such as blue, 

red, yellow, etc. 
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Ideographic language: A written language in which each character (ideogram) represents 

a thing or an idea (but not necessarily a particular word or phrase). An example of such a 

language is written Chinese (MultiMult). 

Interlace: A technique of retrieving images in different stages, with rough image 

appearing first and gradually getting more refined. 

Italic: Fonts with a tilt to the right. (Italic) 
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Jamo: A set of consonants and vowels used in Korean Hangul. The word jamo is derived 

from ja, which means consonant, and mo, which means vowel.  

JPG/JPEG: Joint Photographic Experts Group, file format to store and retrieve images. 
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Kanji: Chinese characters or ideograms used in Japanese writing. The characters may have 

different meanings from their Chinese counterparts. 

Katakana: A Japanese phonetic syllabary used primarily for foreign names and place 

names and words of foreign origin. The symbols are angular, while those of Hiragana are 

cursive. Katakana is written left to right, or top to bottom.  

Kern: To bring together characters, for a better fit of strokes and white space. In display 

type, characters often need to be kerned because the white space between characters at 

large sizes is more noticeable 

Kicker: A brief phrase or sentence lead-in to a story or chapter; usually set smaller than 

the headline or chapter title, but larger than text type. 

Knockout: In printing, when one color is to be printed immediately adjacent to another 

color; actually, they are printed with a slight overlap. 
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Landscape: Width wise orientation of document. In this style document width is more 

than its height. 

Language: With respect to Engravers, Vinyl Cutters, Plotters, Printers, and related Devices 

is the software codes used to communicate between Leonardo Design Studio and the 

Device. Also knows as the Emulation. Typical examples are CSR, DMPL, HPGL and RTL. 

Lap register: Used with knockouts, images of different colors are slightly overlapped, to 

avoid the appearance of a white line between the two inks. 
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Leader: A line of dots or dashes to lead the eye across the page to separated copy. 

Leading: (pronounced "led-ding") the space between lines of type, traditionally measured 

baseline-to-baseline, in points. 

Legacy: Any version of software that has been subsequently superseded by a newer 

version. 

Letterforms: In typography, the shapes of the characters.  

License Management Regime: The system employed by Future Corporation and the 

Software to manage the Software's Licensing on a computer. 

License Remaining: The contiguous time remaining (usually reported in days) before the 

License expires on a computer. 

License Status: The current state of the Software License on a computer. 

License Type: The method of payment for the Software License. 

Logotype: A symbol, mark, or identifying name. Commonly known as a logo, is the graphic 

element of a trademark or brand, which is set in a special typeface/font, or arranged in a, 

but legible, way. The shape, color, typeface, etc. should be distinctly different from others 

in a similar market.  

Lowercase: The small alphabetic characters, whether accented or not, as distinguished 

from the capital alphabetic characters. The concept of case applies to alphabets such as 

Latin, Cyrillic, and Greek, but not to Arabic, Hebrew, Thai, Japanese, Chinese, Korean, and 

many other scripts.  
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MBCS: Multibyte Character Set. A set of characters in which each character is represented 

by 1 or more bytes. 

Mezzotint: For a halftone, a special screen that produces connected, dusty-looking dots. 

Multilingual: An application such as Leonardo Design Studio that can simultaneously 

display and manipulate text in multiple languages.  

Multimedia: Combination of video, music, lighting, CD/DVD-ROM and the internet for 

learning, work or teaching. 
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Negative space: In design, the space where the target in artwork isn't, often the 

background; in a publication, the parts of the page not occupied by type or graphics. 

Nested stories: In newsletter/magazine layout, stories run in multiple columns at different 

column depths. 

Novelty typeface: A typeface that does meet standard typography conventions such as 

serif or sans serif. 
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OEM: A variation of the Software that is exclusively included (bundled) and licensed by 

Future Corporation with a piece of third-party equipment or hardware (machines and 

devices) including but not limited to: CNC, engraving, laser, plotting, printing, routing and 

vinyl cutting machines and devices by the manufacturer and/or their agents and dealers 

to end-users 

Objected-oriented (mode): Draw graphics mode. A set of algorithms describe graphic 

form in abstract geometrical terms, as object primitives. 

Outline: The outer edge of text or graphic.  
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Pantone matching system: The Pantone matching system is used for specifying and 

blending match colors. It provides designers with swatches of over 700 colors and gives 

printers the recipes for making those colors. 

Pica: A measurement used in typography for column widths and other space 

specifications in a page layout. There are 12 points in a pica, and approximately 6 picas to 

an inch. 
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Pinyin: A system to phonetically render Chinese ideograms in a Latin alphabet.  

Pixel (picture element): The smallest unit that a device can address. Most often refers to 

display monitors, a pixel being the smallest spot of phosphor that can be lit up on the 

screen.  

PNG: Portable Network Graphics. Bitmapped image format that employs lossless data 

compression. The PNG format displays images without jagged edges while keeping file 

sizes relatively small, making them popular on the web. 

Point: A measurement used in typography for type size, leading, and other space 

specifications in a page layout.  

PPI: Stands for pixels per inch. PPI specifies the resolution of an input device, such as a 

scanner, digital camera, or monitor. Web page resolution ranges from 72-96 pixels per 

inch.  

Posterization: For a halftone, the reduction of the number of gray scales to produce a 

high-contrast image.  

Printer font: High-resolution bitmaps or font outline masters used for the actual laying 

down of the characters on the printed page, as opposed to display on the screen. 

Process color separation: In commercial printing, used for reproduction of color 

photographs. The various hues are created by superimposition of halftone dots of the 

process colors: cyan (a greenish blue), magenta (a purplish red), yellow, and black.  

Product Life: The period from where a version of the Software is released for licensing to 

the public (the current version) and remains current up until such time as a subsequent or 

replacement version (Upgrade) is released for licensing to the public. 

Product Serial Number or PSN: The unique and identifying number for each Future 

Corporation Software product. 
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Quick Time Video: Video streaming technology developed by Apple. 
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Resolution: The crispness of detail or fineness of grain in an image. Screen resolution is 

measured in dots by lines (for example, 1280 x 1024); printer resolution is measured in 

dpi (for example, 300 dpi). 

Reverse: A method used in printing where background color is generally black color or 

where background becomes inked, and the image and lettering appear in the color of the 

paper. 

Reverse Fill: A solid shape in an off-white color so that it may be viewed over and above 

any other shapes that are of the same color behind it, making it otherwise impossible to 

see. 

RGB: An additive color model in which red, green, and blue light are added together in 

various ways to reproduce a broad array of colors. 

Run-around: Type that is set to fit the contour of an illustration, photo, ornament or 

initial. 

Run-in heading: A heading set on the same line as the text, usually in bold or italic type. 

Running heads/feet: Titles (often accompanied by page numbers) set at the top/bottom 

of text pages of a multi-paged publication.  
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Sans Serif Typeface: A typeface that does not have the small features called "serifs" at the 

end of strokes. The term comes from the Latin word "sine", via the French word sans, 

meaning "without". 

Saturation: Intensity of color. It refers to the degree of difference from gray. High 

saturation will appear to be bright and low saturation will appear dull. 

Script: A set of characters used to write a particular set of languages. For example, the 

Latin (or Roman) script is used to write English, French, Spanish, and most other European 

languages; the Cyrillic script is used to write Russian and Serbian.  
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Security-1 or S1: An extension, variation, or modification of the Software that (i) is for use 

within a secured or protected internal network, and/or (ii) provides for restricted user 

levels and access, and/or (iii) has built-in mechanisms to track all access and use of the 

Software, and/or (iv) implements strong encryption to protect Output and Export files. 

Serif: A typeface has semi-structural details on the ends of some of the strokes that make 

up letters and symbols. A typeface that has serifs is called a serif typeface (or serifed 

typeface). 

Solarization: Over exposure that results in reversal of a photographic image. 

Spot Color: Refers to the use of solid color usually defined as a Lab color or a separate and 

printable ink channel. 

Strong Encryption: A method of data encryption that is less susceptible to having its key 

discovered by a third party through what is commonly referred to as brute force attack, 

hacking or cracking. 

Top of Page 

T 

Tags: A set of characters used in the markup language for providing formatting 

information of a document. 

Template: A document that can be changed or customized and saved with a new name 

without affecting the original document. 

Text wrap: A feature that sets paragraph text to physically wrap around the perimeter of 

another object with or without an offset. 

TIFF (Tagged Image File Format): For digital gray-scale halftones, a device-independent 

graphics file format. TIFF files can be used on IBM/compatible or Macintosh computers 

and may be output to PostScript printers. 

Type alignment: The distribution of white space in a line of type where the characters at 

their normal set width do not fill the entire line length exactly. Type maybe aligned left, 

right, centered, or right justified. 

Typeface: The set of characters created by a type of designer, including uppercase and 

lowercase alphabetical characters, numbers, punctuation, and special characters. A single 

typeface contains many fonts, at different sizes and styles. 

Type families: A group of typefaces of the same basic design but with different weights 

and proportions. 
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Update: A separate component of Software designed to update, modify, repair, remove 

or fix problems identified by Future Corporation with the Software that includes fixing 

bugs, replacing or removing tools and/or features and improving the usability or 

performance of the Software (e.g. V1.0 of the Software may be replaced with V1.1 of the 

Software, with V1.1 an update from V1.0, with V1.1 potentially followed by V1.2 and so 

on and so forth). 

Upgrade: The complete replacement of the Software with a newer version of the same 

branded Software, that may include but is not limited to: error corrections, modifications, 

removal/replacement of tools and features, compatibility improvements, new tools and 

features, additions and/or enhancements to the Software (e.g. V1.0 of the Software will 

be replaced with V2.0 of the Software, with V2.0 an upgrade from V1.0, with V2.0 

subsequently followed by V3.0 and so on and so forth). 
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Vector: A scalable shape generated from mathematical descriptions that determine its 

position, length and direction(s). 

Volume License: Either (i) a Site License granted in single licenses, or (ii) a License Pack 

usually granted in multiples of five (5) five licenses, or (iii) License Seats usually granted in 

multiples of one hundred (100) licenses. 
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Weight: denotes the thickness of a letter stroke, light, extra-light, "regular," medium, 

demi-bold, bold, extra bold, and ultra-bold.  

White space: in designing publication, the areas where there is no text or graphics - 

essentially, the negative space of the page design. 

Widow: in a page layout, short last lines of paragraphs - usually unacceptable when 

separated from the rest of the paragraph by a column break, and always unacceptable 

when separated by a page break. 
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X: One of the three CIE tristimulus values; the red primary. 

x-height: The height of the lowercase "s." Sometimes referred to as "body height." More 

generally, the height of the lowercase letters. 
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Y: One of the three CIE tristimulus values; equal to the luminous reflectance or 

transmittance; the green primary 

Top of Page 
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Z: One of the three CIE tristimulus values; the blue primary. 

Z-Order: The relative stacking order of objects between each other (above and below). 
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